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1 Introduction 
 
These training notes give users a reference during and following Lesson Attendance training. They 
cover all the main sections of the software and help guide the user through the main functions of 
the system.  References to the pages in the corresponding software manuals give participants 
ready access to areas covered during the day’s sessions. 
 
The Lesson Attendance module offers schools an effective and timesaving facility for: 
 

 Data entry via the keyboard or mouse 

 Entering Late arrivals via the Lates window, with attendance updated automatically. This 
function also prints Late Slips for students to give to teachers 

 Entering absences via Speed Entry, with attendance updated automatically with “present” 
marks for the remaining students and 

 Future absences can be entered for absences known in advance. 
 
The module avoids the need for time-consuming manual statistical calculations.  A range of 
standard reports and analyses is included with the system. 
 
Lesson Attendance also saves time in the preparation of letters and attendance reports.   
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1.1 Lesson Attendance Training Program 

 

Time Content 

8.45 am Coffee 

9.00 Introduction to Administration Manager 

 Logging On / User Access 

 File Menu 

 Student Details 

 School Details 

 Groups 

 Administration Manager Reports 

10.30 Morning Tea 

10.50 Lesson Attendance  

 Parameters  

 Day View 

 Week View 

 Student View  

 Registration 

 Lates  

 Speed Entry  

12.20 pm Lunch 

1.00 Absences 

            Future Absences 

 Absence and Lates Follow Up 

 Changing Students’ Roll Status 

Reports 

 Lesson Attendance Reports 

2.30 Afternoon Tea 

2.50  Creating a New Attendance Year (Optional) 

User Access 

Review 

Questions/Practice Session 
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1.2 Training Outcomes 

At the end of the training sessions participants should be able to: 
 

 Navigate their way through the side bar options in the Lesson Attendance module 

 Create Daily Records 

 Set up Default settings in Lesson Attendance Parameters 

 Record absences using:  
o Lates 
o Day View 
o Week View 
o Student View 
o Registration 
o Speed Entry 
o Future Absences 

 Set up and print follow-up letters 

 Use the Absence and Lates Follow Up function 

 Create a New Attendance Year 
  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 11 of 157 

© 2016 Civica Pty Ltd 
 

 

1.3 Logging On 

Activity: Logging On 
 

 Double click on the Integris Training icon on the desktop 
 

 
 

 Type OSWALD as the User Name for use in today’s training 

 Press <Tab> to move the cursor to the Password box  

 Enter the password: keys 
 

 
 

 Click on Login or press <Enter> 
 

Note:  In schools, each user has their own user name and password, which enables access 
to particular sections of the software as determined by the school administration.  It is 
strongly recommended that you change your password once the software is installed in 
your school 
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1.4 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 

 
 

 Change User should be used to ensure that each person accessing Integris does so under 
their own user name and with their personal levels of access. 

 Password enables the user to change his or her password.  For security purposes, it is 
recommended that this is done regularly. 

 Lock Terminal may be used if the user needs to leave his or her computer temporarily, does 
not want to log off and does not want to allow access to anyone else.  Unlocking the terminal 
requires the user to enter his or her password again. 

 Report Destination allows the user to choose where to send any report created in Integris.  
The options are displayed below. 

 

Activity: The File Menu 

Top Toolbar > File 

 View each of the following items in the File menu 
o Password 
o Change User 
o Lock Terminal 
o Report Destination 
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1.5 Accessing Help 

Activity 

Top Toolbar > Help > Help Contents and Index 

 Click Help in the top toolbar 

 Select Help Contents and Index 
 

 
 

 Highlight Integris Lesson Attendance Help 

 Click Help 

 View the Lesson Attendance manual  

 Close the manual  
 

 

 In the same way, view Lesson Attendance Reports Help 
 

 
 

 Close the manual  
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 In the same way, view Lesson Attendance Using Registration 
 

 
 

 Close the manual and help 
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2 Administration Manager  

2.1 Using the Side Bars  

Once you have logged onto the system a blank window with a control panel (side bar) appears 
down the right-hand side of the screen.  The General side bar is displayed. 
 

            
 
  

 
The Administration module comprises of two 
sidebars.  The one displayed on the left of this page 
is the General side bar. This provides access to the 
core functions.  From here you can enter school 
details, view and enter student and staff details and 
create groups of students and staff.  
 
It is also where schools set up their own 
parameters for the system and use the Control 
function to add new modules at a later date, and 
set up new users and passwords. 
 
By clicking on the Admin tab on the bottom of the 
side bar a second bar is revealed over the General 
side bar.  This is the Admin side bar which 
provides an emergency report function, enables 
users to speed edit information in students’ records, 
carry out year end procedures and produce reports. 
 
Other sidebars will be available dependent on your 
school and level of access. 
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2.2 Student Details 

General > Student Details 

Student Details display comprehensive information about each student attending the school.  From 
the General side bar choose Student Details.  The following window will appear: 
 

 
 
This is the summary window and displays the basic student data and a photograph of the student 
(where available). 

Photos are accessed by clicking on Display Student Photograph    at the bottom right-hand 
corner of the window. 
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Student Details Toolbar 

 
 
This drop-down menu enables the user to decide which of the rolls they wish to view: the 
Admissions Roll, Current Roll, Former Roll or the External Roll. 
 

  The Next Student and Previous Student arrows on either side of the binoculars allow 
you to scroll through the database either forward or backward in alphabetical order.  

  The Find Student tool enables users to find individual students or groups of students based 
on selected criteria.  
 
To view specific areas of a student’s record use the buttons on the tool bar at the top of the 
Student window: 
 

  Add a new student  

  Edit student data 

  Move a student to the Former Roll 

  Print student details  

  Send a letter 

 Send an e-mail  

  Summary details 

  Additional details 

  Movement History 

  Attendance History  

  Groups 

  Student Activity  

  User-defined Information 

  Medical Details 

  Teaching Sets  

  Miscellaneous details 

  Student timetable 

  Cohorts 
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Student Status Bar  

 
 
The Student Status Bar is designed to be visible from all panes of the window, giving users a view 
of key student indicators at a glance. 
 
The Status Bar is split into two sections, with the left-hand section reserved for more sensitive 
data.  In both sections, information on the current student is displayed using icons.  Hover the 
pointer over an icon and it will display a description of its meaning. 
 

Normal Bar 

 Student has a flagged medical condition 

 Language Background other than English 

 Access restriction 

 Part-time student 

 Accepted (Admissions Roll) 

 VET Student 

 Student Notes 

 Name Change 
 

Sensitive Status Bar 

 Educational Support Program 

 Excluded (Former Roll) 
 

Activity: Student Details 
 

 View each of the screens in Student Details 
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2.2.1 Finding Students 

General > Student Details 

There are five methods of searching for students in Student Details 
 

 Using the Previous Student/Next Student arrows 

 A Simple Student Search 

 Using the standard Integris Find Student function   

 Using the Advanced Student Search   

 Making Siblings the Browse set 
 

Method 1: Using the Previous Student/Next Student Arrows   

The Previous Student/Next Student arrows are located at the top left of the Student window.   
They can be used to scroll through the current browse set of students.  

Click on the Next Student arrow  to move to the next student in the browse set. Click on the 

Previous Student arrow  to move to the previous student in the browse set. 
 

Method 2: Simple Student Search   

The Summary screen in Student Details provides a Simple Student Search facility to enable the 
user to quickly locate and load a specific student’s record. It is located at the bottom left corner of 
the Student window.   
The search operates on the currently defined browse set in the Student Details window. If no 
browse set is defined, the currently selected roll will be searched. 
 

Method 3: Find Student Function   

Another method of finding a student’s record is by using the standard Find function located at the 
top of the Student window. This function is used in other sections of Administration Manager and in 
other Integris modules.  
 
Use the Find Student tool to select students by a variety of different search criteria. Click on the 
Find Student icon and the following window appears. 
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Find a particular student by entering either a surname or roll number in the Name/Number field.  It 
is not necessary to enter the whole surname.  Enter the first few characters and press <Enter>.  A 
list of students’ names matching the characters entered will be displayed.  Double click on the 
appropriate name. 
 
You can find individual students or groups of students by many other criteria such as year group, 
form, teaching set, group, previous school, indigenous status, dates (including birthdays and 
students’ ages), addresses and user-defined information (UDI). 
 
The system can save any search criteria you enter - this is called a Query. A query can then be 
used at a later date to save you setting up the search again. 
 

Method 4: Advanced Student Search   

When searching for students the Advanced Student Search tool can be used to add another 
student or group of students to an existing search results list. 

For example, a normal student search could be performed using the    tool.  Once the desired 
list of students is displayed the Advanced Student Search tool could be used to add more students 
to the existing list. 

Method 5: Make Siblings the Browse Set 

Once a student’s record is loaded, and any necessary changes have been made, it is easy to 
create a browse set of the student’s siblings so that the siblings’ records can be edited.  In the 
Contacts pane, right click and select, “Make Siblings the Browse Set”. See the following screen 
shot for student Penelope Allen. 
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Activity: Simple Search and Make Siblings the Browse Set 

General > Student Details  

 Locate Penelope Allen’s record by entering all or part of her name, then <Tab> or <Enter> 
 

 
 

 Right click in the Contacts pane 
 

 
 

 Select Make Siblings the Browse Set 
 

 Indicates that a Browse Set (a subset of student records) has been created. 
 

 Click Next Student  
 
Tamara-Allen’s records will be displayed. 
 

 Click Previous Student  to return to Jackie’s records 

 Click  and Yes to clear the browse set 
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Activity: Locating Groups of Students 

Find the students in Form Room 7 

 Select Room 7 from the Form drop down list 
 

 
 

 Click Find or <Enter> 
 

 Click Back and clear your settings  
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Find the students in Senior Choir 

 Select Group Type:  2016 Music 

 Select the Group:  2016 Senior Choir 
 

 
 

 Click Find  
 

 Click on the Year heading to sort the students by Year  
 

  
 

 Click Print Find Results  

 Close the Print Screen 

 Click Back and clear the settings  
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Find Students who were born in January  

 Select January  from the month drop down list 
 

 
 

 Click Find or <Enter> 
 

 Click Back and clear your settings  
 

Find students with a Health Condition 

 Find the students who have Diabetes 
 

 
 

 Click Find or <Enter> 
 

 Click Back and clear your settings  
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Activity: Saving a Student Query 

Find students by Teaching Set and save the Query 

 Click on the Teaching Sets/Cohort  tab 

 Find the students in 9ENG_3 
 

 
 

 To save the query click on the floppy disc  icon  
 

 

 Enter an appropriate name for the search 

 

 Click Back and clear your settings  
 
To load a saved query  

 Click View the Query List   

 Highlight 9 English 3  

 Click Load 

 Click Find to locate the students matching the query 
 

Note: Saving a query saves the question not the answer.  Every time the query is loaded, an 
up-to-date list of the students matching the search criteria is displayed. 
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Activity: Advanced Student Search 

Find the Year 8 and 9 Boys 

 Click Find   

 On the General tab, select Year Group: 8 
 

 
 

 In the Parameters tab, select Gender: Male 
 

 
 

 Click Find or <Enter> 
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 Click Advanced Find    to search for the additional students to add to the query 
 

 
 

 Click Add Students    to find for the Year 9 boys  
 

 
 

 Click Find, Select and Yes 

 Click on the Form column header to sort into Forms 

 Click Print    and send the report to the screen 

 Close the report 

 Click Select and Yes to create a combined list of the Year 8 and 9 boys 

 Click Select and Yes to create a browse set of Year 8 and 9 boys 

 Clear  the browse set by clicking on  
 
Note: There is currently no ability to save advanced searches. 
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2.3 School Details 

General > School Details 

The School Details window is very similar to that in Student Details and some of the icons are 
the same.  The main tools within School Details are: 
             
 
   

 
 
 
 
 

 
 
 
 

 Calculate 
 Current Roll 

 
 
 

Edit School Details  enables the user to maintain details in all areas of the school’s details.   
 

Activity: Viewing School Details 

View each of the following windows in School Details. 

 Sites  

 Directory  

 School Activity  

 Calculate the Current Roll  

 School Diary  

 Timetabling Periods  
 

 
  

Edit school 
details 

School user-defined 
information 

Display school 
details summary 

Maintain information 
about additional 
sites 

Maintain 
directory of 
contacts  

School 
activity log 

Print school 
details 

Send a letter 

Set up and 
maintain the 
school diary 

Set up timetabling 
periods 

Send an 
email 
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Activity: Add an Activity to the School Diary 

General > School Details  

 Click Display School Diary    

 Click Year View   

 Click Add    

 Enter the date for the coming Tuesday in the Date Field, and the following details 
 

 

Term Dates for students for 2016: 

Term 1 – Monday 1 February to  Friday 8 April 
Term 2 – Monday 25 April   to  Friday  1 July 
Term 3 – Monday 18 July  to  Friday  23 September 
Term 4 – Monday 10 October  to  Thursday15 December 
 

 Click OK to save 
 

Note: School Terms are always entered as starting on a Monday.  If the 
school is not open on the Monday, it may be entered as a Closed day in 

the School Diary. 
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View the school planner 

 

 Click Print   

 Select the current term and Select ALL Types 
 

 
 

 Click Print and OK 

 Find the Year 6 AQWA Excursion entry 
 

 
 

 Close the report, the diary and School Details 
 



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 31 of 157 

© 2016 Civica Pty Ltd 
 

2.4 Setting up Groups 

Schools often need to perform functions on a subset of the school population.  Commonly this will 
be by form or class (teaching set).  Groups are a powerful feature that enables a selection of 
students to be defined and used throughout the system, including the Timetabling module. 
 

A group may be defined for a Learning Team, students at risk or any other grouping that a school 
may require to promote learning. 
 

Groups can be categorised in any manner user’s wish. The categories (Group Types) are set up 
within General > Parameters > Group Types. 
 

Once Group Types have been set up; choose Groups from the General side bar to create groups. 
The Groups window opens: 
 

 
 
 

The group types that have been set up within Parameters appear on the drop-down menu.  When 
a type is selected, the groups within that category appear in the pane below.  You can choose to 
look for groups of staff or groups of students. 
 

To set up a new group, first decide if it will be a group of students or staff by selecting the 

appropriate radio button.  Then click on the Add Group icon   within the Groups part of the 
window.   
 

Select a group type and enter a description. Click OK to save the group.  
 

To add students to a group, highlight the name of the group, and then click on the Add Members  

  button.  
 

The standard Student Search window opens. Select the group Members. 

Note: Students and staff can also be added to a group individually by editing their record 
within the Student Details or Staff Details sections of the system. 
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Activity: Student Groups 
 

General > Groups 

 Click on the Groups icon on the sidebar  

 From the Group Types menu, select 2016 Excursions 

 Click Add Group   

 Enter a Group Description and check Parental Consent required 
 

 
 

 Click OK  
 

 Highlight the Year 6 AQWA Excursion and click Add Members  on the right 

 Find the Year 6 students and add all of them to the group 
 

 Highlight most of the students in the list and click Parental Consent given  
 

 
 

 Delete  from the list those students without parental consent 

 Close Groups 
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Activity: Allocating Part Time Status to Student 

General > Student Details  

Luke Andrews is a Kindergarten student who is attending school for 2 ½ days of every week. 
 

 Load Luke Andrew’s records  

 Click Edit  

 Go to the Additional tab 

 Enter an FTE of 0.5 and press <Tab> 
 

 
 

 Click Assign Part Time Pattern   

 Click on Friday morning and every afternoon to deselect them 
 

 
 

 Click OK 
 
Once Part Time status has been allocated to students, the daily records will reflect when the 
students should be at school according to their attendance pattern. 
 

 Click OK and OK  
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2.5 Reports for Manual Attendance Recording 

Reports may be accessed on a wide variety of information required by the school and other 
authorities. 
 
Standard reports can be found by selecting Reports from the Admin sidebar. Some of the Reports 
in Admin are useful for teachers who are responsible for recording Attendance data. 
 

 
 
Each folder on the left-hand side contains reports.  To run a report, click on the relevant report to 
highlight it.  Any Sort Fields and Options will be displayed on the right of the window. 
 

 
 
For any Form List report choose your report options (Year, Form etc.) and, to sort the report by a 
particular field, drag the field name from the Sort Fields box on the left into the Sort Field box on 
the right.  When all the details are correct, click Print and choose a destination for the file. 
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The General and Roll Reports do not have the same options as the Form List; instead you are 
asked to select students using the New Query button: 
 

 
 
This enables users to select students based on a previously saved query (these appear on the 
drop-down menu), or to select a new query.  Selecting New Query brings up the standard Student 
Search window. 
 
Once the query has been defined, click on the Print button and choose a destination for the file. 

Note: If you often run a standard report using the same criteria, you can save the settings 

 for future use by clicking on the Save as a Custom Report button.  This stores the 
report settings in the Custom Reports folder. 

  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 36 of 157 

© 2016 Civica Pty Ltd 
 

2.5.1 Weekly Checklist-Admin Reports 

 

Activity: Print a Weekly Check List 

Admin  > Reports > Check Lists > Weekly Check List 

 Produce a Weekly Check List for Form: Room 6  

 Include am/pm,  Number of weeks 2 , Week Commencing next Monday’s date  
 

 
 

 Print the report to the screen 
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2.5.2 Home Room and Form List 

Activity: Print Home Room and Form List 

Lesson Attendance > Reports > Attendance Forms > Home Room and Form List  

 Primary: select Rooms 1 to 6  and Select Split Day Columns 

 Secondary: select 7.1 to 7.2  

 Enter the current term and week 
 

 
 

 Print the report to the screen 
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3 Lesson Attendance 

3.1 Parameters 

Lesson Attendance > Parameters 

 
 

3.1.1 Attendance Codes  

Lesson Attendance > Parameters > Attendance Codes 

These codes must not be edited or deleted in WA Department of Education schools. Changes will 
adversely affect reports and modules such as Behaviour, Census, Lesson Attendance and 
Transitional Reports. 
 

 

Note:  Z and W codes are managed by the Behaviour module.  They cannot be selected in Lesson 
Attendance when entering absences as it is a Department of Education and Training requirement that 
all schools use the Behaviour module to record suspensions and withdrawals.  The Y code is 
accessed through Lesson Attendance > Parameters > Enforced School Closure.   
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3.1.2 Lesson Attendance Defaults 

Lesson Attendance > Parameters > Defaults 

 
 
Default absence codes may be changed by schools if appropriate.  Home period counting may be 
edited.  This will impact on the session attendance code. 
 
Minimum percentage attendance required per session must be set at 75%.  This is a 
Department of Education standard and is only to be changed in consultation with a STIMS Admin 
Team – Senior Project Support Officer. 
 
Daily record management mode (on exiting Speed Entry): 

 Automatic Daily record management - this setting provides a function when Speed Entry is 
exited and there are just a day’s records to create, the creation of the records will occur 
automatically.  This is the recommended option. 

 Manual Daily record management - when the user exits Speed Entry the Daily Records 
window will be displayed so the user can create the necessary daily records. 

 Off mode - the daily records can only be created from Parameters > Create Daily Records. 

Report Instructions 

The text entered here appears at the bottom of the Morning Absentee Report.  This may be edited. 
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Lesson Attendance > Parameters > Defaults > System Management 

System Management can be switched on or off.  This will control whether the taking of registers is 
logged via the Registration option.   

Note: This only applies when the Timetabling module is loaded. 

AM/PM code clicks: There are three options that control direct changes to AM/PM codes in Day 
View and Student View windows: 

 No Confirmation Required – users will be able to change AM/PM codes freely 

 Confirmation Required – users will be asked to confirm changes to AM/PM codes 

 No Changes Allowed – users (other than Administrator users) will not be able to change 
AM/PM codes 

 
A Default Attendance Code must be selected from the drop down list of approved codes.  The 
default should be set to / Present although it is possible to alter this. 

Note: Department of Education (WA) schools should use / Present as the default code.  

Day View Right Clicks: By default use of the right mouse click in the Day View window will update 
the selected period and all remaining periods in the day which are after the selected period.  The 
administrator can elect to restrict the use of this right click function.  The options are: 
 

 Enable Right Clicks in Day View: - The right mouse click will update remaining periods in the 
day (default mode) 

 Disable Right Clicks in Registration Mode: The right mouse click will work in the Day View 
window except when the Day View window has been opened via the Registration icon 

 Disable Right Clicks in All Day View modes: The right mouse click will not operate in the 
Day View window however it is opened 

 
Evacuation Report Settings: The Evacuation Report is available in two styles - By Year, which 
will print the whole report on a page, sorted by year and then surname, and By Form, which will 
print a Year Group on each page separated into form groups.   
 
Track Attendance Changes: Enables detailed logging of changes made to the AM and PM codes 
for student attendance records.  
 
Day View – Place students located via Student Find to the top of the list: When un-ticked the 
Day View window will always sort students alphabetically.  When ticked, students located by the 
Find tool, will be sorted in the order they were found. 
 
Default Registration Times: Department of Education (WA) schools will not use this option. 
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Activity: System Management Settings 

Lesson Attendance > Parameters > Defaults > System Management 

 
View the System Management Settings 
 

 
 
 
Exit Lesson Attendance Options  
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3.1.3 Enforced School Closure 

Lesson Attendance > Parameters > Enforced School Closure 

This special ‘Y’ code can be assigned to students when the school, or part of the school, has had 
to close. Students assigned this code are not counted in Attendance. In effect the code is similar to 
a school closed code (as found in the School Diary). The student is not present, but neither are 
they counted as absent. 

Note:  The ‘Y’ code can only be assigned to students in the utility:  Lesson Attendance > 
Parameters > Enforced School Closure. 

To ensure that it cannot be used in any other way, the following will apply: 

 You cannot edit or delete in Parameters > Attendance Codes 

 You cannot map the code in Parameters > Map Attendance Codes 

 The code is not accessible in Parameters > Defaults 

 The Code does not appear in Day View, Week View or Student View 

 The Code does not appear in the Speed Entry or Lates 
 
Enforced School Closure can only be accessed by a single user at any one time. If this function is 
being used and another user attempts to access the function, the following message will appear. 
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3.1.4 Enforced School Closure for Selected Groups 

 
Schools may use the Enforced School Closure Function to manage the attendance of students 
with an irregular part-time attendance pattern, e.g. If you are recording attendance for Kindergarten 
students attending three days one week and two days the next. 
 

 
 

Note:  If there is any existing attendance data on the date selected, it will be overwritten, 
unless that data is an Authorised or Approved Absence Code. 

 

 

School Closure in the Week View Screen  
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Activity: Enforced School Closure 

Lesson Attendance > Parameters > Enforced School Closure 

The Teachers union have launched industrial action. The whole school will be closed next 
Monday morning. 
 

 Enter the information as per the screenshot 
 

 
 

 Click Apply School Closure 

 

 
 

 Click Yes 

 

 
 

 Click OK 

 Exit School Closure 
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3.2 Day View 

Lesson Attendance > Day View 

 
 
 
Day View is used for:  

 Viewing data day by day 

 Initial data entry  

 Updating data  
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Options for finding and loading student records include by Form, Teaching Set, Name, or by the 
Find tool.  If the Timetabling is loaded, users may choose My Form and My Sets. 

Note:  For My Form and My Sets to function correctly the Staff link must be activated in the 
User settings in General > Control > Users > Edit User and for My Sets the school must 
have the Timetable module loaded. 

Date selection: Defaults to the current date on opening the window.  Users can enter the date by 

typing it in or by using the Select Date function.   
 
The Cycle, Cycle Start Date and Attendance Year that are displayed in the window have been 
set up in Lesson Attendance Parameters. 
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Displaying Attendance Code Key 

Lesson Attendance > Day View 

 Click on the selected code to view description, enlarged above the list of codes 
 

 
 

 Use the Display Key function  to view list of all codes and descriptions 
 

 
 

Note:  Z and W codes are managed by the Behaviour Manager module.  They cannot be 
selected in Lesson Attendance when entering absences as it is a Department of Education 
and Training requirement that all schools use the Behaviour module to record instances of 
suspensions and withdrawals. 
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3.2.1 Displaying Attendance Data by Form 

Activity: Display Data by Form 

Lesson Attendance > Day View 

 Select the Form option (may already be defaulted) 

 Enter the date 4th February 2016 

 Select Room 4 from drop down list 
 

 
 

 View the attendance records and read the notes by clicking on the ticks in the Notes  
column  
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 View attendance records and read the notes for Form 8.1 for 4th February 2016 
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3.2.2 Day View-My Form 

Activity: 

Lesson Attendance > Day View 

 Select My Form   
 
Ms Oswald’s form will be automatically loaded 
 

 
 

 Go to Today’s date 

 Ensure that absence code U is selected 

 Right click in the H (Homeroom) column for Ryan Cooper 
 
All columns will automatically be updated. 
 

 Left click in the AM cell for Josh Johnston, read the message and click Yes 

 Repeat for the PM cell, read the message and click Yes 

Note:  The period structure is not automatically updated 

 Right click in the H cell for Josh Johnston, read the message carefully then click on Yes 
 

 
 

 Click OK to save the changes 
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3.2.3 Day View- Entering Attendance Data 

Activity: Enter Attendance Data 

Lesson Attendance > Day View 

Enter and save data for TODAY for the following Primary students who are absent from Form 
Room 5  
 
o Steven Brown 
o Steven Farnton 
o Tenille Gray 

 

 Select the Form radio button 

 Select Form Room 5 
 

 
 

 Enter U in the AM and PM sessions by right clicking in the AM cell 

 Click OK to save the data 
 

Mason Richards (Room 6) has brought a note to say he has a dental appointment this 
afternoon. 

 Select Form Room 6 

 Select absence code R 

 Left click in the PM cell 

 Click in the notes column  
 

 
 

 Enter a note 
 

 
 

 Click OK  and OK to save  
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3.2.4 Day View- Updating Students’ Existing Records 

Activity: Update Student Absences  

Lesson Attendance > Day View 

The following Form 9.1 students were participating in the Keep Australia Beautiful program. 
They were absent from Homeroom, and periods 1 and 2 on 8th February 2016:  
 
o Christine Carter  
o Aiden Eren  
o Travis Le-Ti 

 

 Enter an absence code of E (Educational Activity) for the relevant periods. Overwrite the 
existing U (unexplained absence) code 

 

 

 Click on Notes  for one student 

 Enter the note  

 Use Ctrl + C to copy the note and Ctrl + V to paste into the other two students notes 
 

 
 

 Click OK and OK to save 
 

Note:  Multiple absences can also be entered in Speed Entry. 
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3.2.5 Day View-Selecting Students by Teaching Set 

Activity: Record Absences by Teaching Set 

Lesson Attendance > Day View 

 Select Today’s date 

 Click the Teaching Set radio button 

 Choose 10Art_1from the drop down menu 
 

 
 

 Record the fact that Hanna Hill and Emily Lewis were truanting period 2 

 Click OK to save 
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3.2.6 Day View-My Sets 

Activity: Record Absences Through My Sets 

Lesson Attendance > Day View 

 Click the My Sets radio button 

 Click on the down arrow adjacent to the Teaching Set field to view Sharyn Oswald’s Teaching 
Sets. Select 11HR1 

 

 
 

 Leave the date as Today’s date 

Note: Only those teaching sets for the logged on user are displayed. 

 

 
 

 Marc Kitchen in 11 HR_1 class was sent to the Medical bay during period H 

 Click OK to save 
 

Note: This window gives access to the full period structure.  The Registration Window will 
restrict the user to the period appropriate to the day and teaching set. 
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3.2.7 Day View-Finding/Loading Individual Student Records 

Activity: Record Individual Absences 

Lesson Attendance > Day View 

The following students are absent all day today.  Load their records individually and record 
their absences. 

Primary: 

o Tamara Allen  
o Penelope Allen (the first two students can be loaded together)  
o Keith Jones  

 

 Select Student Find 

 Enter ALL in the Student/Ref. No. field and <Enter> 
 

 
 

 Highlight Tamara and Penelope Allen, click Select and Yes 

 Change the code to U 

 Right click on the AM cell to record an all-day absence for both students 
 

 
 

 Click OK to save 

 Enter JON,K directly into Student/Ref. No. and <Tab> 
 

 
 
Keith is added to the student list 
 

 
 

 Right click on the AM cell to record an all-day absence  

 Click OK to save 

 Click Clear Student Selection  and Yes 
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Lesson Attendance > Day View 

The following students are absent all day today.  Load their records individually and record their 
absences. 

Secondary :  

o Ben Anderson 
o Rachael Andrews 
o Tracey Bennett 

 

 Select Student Find 
 

 
 

 Enter AND in the Surname/Ref. No. field and <Tab> 
 

 
 

 Holding down <Ctrl> select Ben Anderson and Rachael Andrews  

 Click Select and Yes  

 Right click in the Homeroom (H) cell to record an all-day absence for both students 
 

 
 

 Click OK to save 

 Enter BEN,T directly into Student/Ref. No. and <Tab> 
 

 
 

 Right click in the Homeroom (H) cell to record an all-day absence  

 Click OK to save 

 Click Clear Student Selection  and Yes 
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You have received a phone call to say that Cory and Damien Ramsay are absent today, as they 
are both sick.  Record the data. 

Lesson Attendance > Day View 

 Enter their surname in the Student Surname field and press <Enter> 
 

 
 

 Select both names from the list  
 

 
 

 Click Select and Yes 
 

 Select the N code and record their all day absence 
 

 
 

 Enter a note for each of them 
 

 

Note:  You can copy the text in a note (Ctrl + C) and paste it (Ctrl + V) into another note. 

 Click OK to save  

 Click Clear Student Selection  
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Sacha Busuttil, Ashleigh Campbell and Gemma Clarke have been withdrawn from choir class this 
afternoon for Cultural/Religious reasons. 

Lesson Attendance > Day View 

 Click Find Students  

 Find Group Type 2016 Music and 2016 Senior Choir  
 

 
 

 Click Find 
 

 
 

 Highlight the three students in the list, click Select and Yes 

 Select the attendance code C 

 Left click in the period 5 cell only for all students 
 

 
 

 Click OK  
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3.3 Week View  

Lesson Attendance > Week View 
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Week View is used for: 
 

 Viewing a week’s data 

 Initial data entry  

 Updating data  
 
Student records may be loaded by Form, Teaching Set, Name, or by Find Student tool.  If the 
Timetabling is loaded, users may choose My Form and My Sets.  These are the same as Day View 
options. 

Note: For My Form and My Sets to function correctly, the Staff link must be activated in the 
User settings and the User must be on Timetable. 

Date Selection 

The date will default to the current week in the Timetable cycle.  The Blue navigation arrows only 
become active once student records have been loaded.  Users can enter the date by typing (e.g. 

Week commencing 170216 or using the Select Date button   . 
 
The cycle, cycle start date and attendance year that are displayed in the window are drawn from 
the Lesson Attendance year, set up in Parameters. 
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Period Structures 

Where students have a structure that includes periods, any changes made to am/pm attendance 
codes in this window will be reflected in the period attendance codes stored for the student.  For 
example, if a student has a code ‘R’ entered for a morning session, their morning periods for that 
day will display the same code (R) in Day View. 
 
On some occasions the data that is being entered conflicts with data that has already been entered 
for the student. In such instances, the user will be directed to use the Day View window to ensure 
accuracy of the data to be recorded. 
 
Enter comments in Week View by right clicking on either the AM/PM session for the appropriate 
day. 
 

3.3.1 Week View- Entering Attendance Data 

Activity: Enter Attendance Data 

Lesson Attendance > Week View 

 
Enter data for last week for Room 4 students.   

 Enter last Monday’s date for the start of the week 

 Select the appropriate attendance code and left click in each of the cells you wish to mark 

 Right click to enter a note for Matthew North’s absence on Friday 
 

 
 

 Click OK to save 
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Lesson Attendance > Week View 

 Enter and save data for last week for the following Form 8.1 students 
 

 
 

 Click OK to save 
 

Record the following attendance details. 
 
Simon Halligan’s father phoned.  He was sick from 10th to 12th February 2016 
 

 Update his records - use the N  absence code and enter a note (Right Click) to record the 
telephone call  

Note: You can copy the text in a note (Ctrl + C) and paste it (Ctrl + V) into another note. 

Tiffani Price truanted yesterday (or last Friday). 
 

 Record this, using the T code 

 
Ashlee Holt has brought a medical certificate for this morning.  
  

 Record this, using the R code  
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3.4 Student View 

Lesson Attendance > Absences > Student View 

 
 
The Student View window displays attendance records for a given student covering a given date 
range. The window also displays a list of dates on which absence follow-up letters have been sent. 
 
Student View is accessed by:  

 Clicking on the Absences icon in the Lesson Attendance sidebar and 

 Selecting Student View from the menu 
 
Users have four options for displaying attendance data for a student: 
 

 
 
Codes are entered in the same way as in Day View. 
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3.4.1 Student View- Viewing Records 

Activity: Student View 

Lesson Attendance > Absences > Student View 

 Click the Absences that require follow-up radio button 
 

 
 

 Enter the date range 3rd February  to TODAY  
 

 Load Jackie Albert’s records   

Note: The dates that absence follow-up letters have been sent are displayed in the bottom 
right corner of the screen window  

 Use the Print button  to print the data to the screen 

 Use the  clear Jackie’s record from the screen 
 
You have had an enquiry about Tamara Bandy’s attendance. 

 Choose All days with Absences and Lates 
 

 
 

 Load Tamara Bandy’s records   

 Use the Print button  to print the data to the screen 
 

 

3.4.2 Student View- Updating Attendance Records 

Activity: Update Absences Through Student View 

Lesson Attendance > Absences > Student View 

The following letters have been returned from students’ parents. Update the Primary OR the 
Secondary student’s records. 
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Primary Student: 
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Secondary Student 
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3.5 Registration  

Lesson Attendance > Registration 

The Registration option allows users to register that attendance data has been recorded.  For this 
function to work effectively, teachers will need to be set up as users and must be linked to staff in 
General > Control > Users > Staff Link.  The Registration window will automatically display the 
user’s staff code as set up in Staff Details.  The date will default to the current date and the 
teaching set that the logged on user is scheduled to teach (based on the current time) will be 
displayed in the Group field. 
 
For schools that have a mixed setup using both timetabled and non timetabled attendance groups, 
when Registration is selected the following window is displayed: 
 

 
 

 Select the appropriate Year Group and click OK 
 
If the school does not have a timetable at all, then Registration is selected and the window on the 
left is immediately displayed.  If all Your Groups are timetabled, then Registration is selected and 
the window on the left is immediately displayed.   
 

     
 
Non-timetabled Year Groups    Timetabled Year Groups 

Note: If the Year Group selected is not timetabled, then the Form menu displays all of the 
school’s Form Groups.  If the Year Group selected is timetabled, then Group menu displays 
the logged-in teacher’s classes for that day. 

 Select the class to register from the Form or Group menu 

 Click Register  
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The Day View window will open.  For non-timetabled schools, all columns displayed may be edited.  
For timetabled schools, only the column for the chosen period may be edited.  
 

 Click in the relevant cells to record absences and then click OK  

Note: Even if no changes are made, the user must click OK to create an entry in the Audit 
log. 

 Click OK again to confirm that register has been taken 

 Click Exit to return to the Registration window. 
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3.5.1 Registration-Timetabled Groups 

Activity: Registration for Timetabled Groups 
 
Complete Registrations details for Sharyn Oswald for TODAY for the following teaching sets and 
absent students. 

Lesson Attendance > Registration  

 
 

 Select Year 11 and click OK 
 

 
 

 Select the first teaching set in the list 

 Click Register 
 
This will open Day View with the appropriate period highlighted. 
 

 Left click in the cell for the students Rachael Andrews and Nathan Leslie  to mark them as 
absent 

 

 Click OK twice  

 Click OK to the message that the register has been confirmed 

 Click Exit 
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3.5.2 Registration-Non-timetabled Groups  

Activity: Registration for Non-Timetabled Groups 

Lesson Attendance > Registration  

 
 

 Select Year 4 and click OK 
 

 
 

 Select Room 4 and click Register 
 
This will open Day View. 
 

 Left click in the AM cell for the students Julie Edwards and Matthew North  to mark them as 
absent 

 

 Click OK twice  

 Click OK to the message that the register has been confirmed 

 Click Exit 
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3.5.3 System Management Reports (Registration) 

Lesson Attendance > Parameters > System Management Reports 

Management Reports provides a quick and easy method of checking which classes have had their 
attendance recorded through the registration function.  The report can be generated for either a 
single period or a daily summary.  An option also exists to either hide or show completed registers. 
 

3.5.4 System Management Reports-Primary 

Activity: System Management Reports 

Lesson Attendance > Parameters > System Management Reports 

 

 
 

 Select Form Registers and click OK 
 

 
 

 Leave Today’s date and click OK 

 Click Close and Cancel 
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3.5.5 System Management Reports-Secondary 

Activity 

Lesson Attendance > Parameters > System Management Reports 

 
 

 Select Teaching Set Registers and click OK 
 

 
 

 Leave Today’s date and the current period 

 Select Daily Summary  

 Uncheck Hide Completed Registers 

 Click OK  

 Click Close and Cancel 
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3.6 Recording Lates 

Top Tool Bar > Lates 

  
 

The Lates function allows: 

 Fast data entry for late students  

 Use of keyboard for data entry (with the option to use the mouse).  Student data loads 
automatically when the student’s name is entered 

Note: When typing part of the student name into the search window and hitting enter or Tab 
on the keyboard, the select window will display student names in the format of 
<Surname><Preferred Name>. This also occurs in the Speed Entry window. 

There are options to: 

 Change date and time 

 Change the Period/Session  

 Mark the period as late.  (See the text at the bottom of the window.) 

 Include comment 

 Print a late slip 
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3.6.1 Lates-Data Entry 

Activity: Entering Lates 

Top Tool Bar > Lates 

Primary Students 

 Enter  Kingston in the Student/Ref No field  
 

 

(Alternatively, the binoculars may also be used) 

 <Tab> 

 Select Cain 
 

 
 

 Click OK 

Note: Today’s date, current time, attendance code U and comment (time of arrival) are also 
displayed. 

 Press<Tab> between fields 

 Leave the Period as AM 

 Press <Tab> to Mark this period as late  

 Use the space bar to check (tick) the checkbox 

 Press <Tab> to the Comments field and add the reason Missed bus 

 Press <Enter> or click OK 
 

  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 76 of 157 

© 2016 Civica Pty Ltd 
 

 

 

 

Note: If we wished to print a Late Slip we would Tab to the Print Late Slip field and use the 
Space Bar to check (tick) the checkbox. 

The updated record is displayed on the screen 
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Secondary Students 

 Enter Ben Smith-Carter in the Student/Ref No field 
 

 
 
(Alternatively, the binoculars may also be used) 

Note: Today’s date, current time, attendance code U and comment (time of arrival) are also 
displayed. 

 Press <Tab> between fields 

 Change the Period to Lesson 2 

 Tick the checkbox Mark this period as late 

 Press <Tab> to the Comments field and add the reason Missed bus 
 

 
 

 Press <Enter> or click OK 
 

Note: If we wished to print a Late Slip we would Tab to the Print Late Slip field and use the 
Space Bar to check (tick) the checkbox. 
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The updated record displayed on the screen 
 

 

Practice entering the following data for late students 

Primary Students 

Troy Dean  
 Time: current time 
 Mark as late 
Kristy Farmer  
 Time: 9.35 AM  
 Mark as late  
 Comment: Missed bus 
 

Secondary Students 

Emily Gold 
 Time: current time 
 Period: 2 
 Mark as late 
 Comment: Slept in 
Stephanie Gold  
 Time: current time 
 Period: 3 
 Mark as late  
 Comment: “Slept in” 
 

 Go to Day View to view the data you have just entered 
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3.7 Speed Entry 

Lesson Attendance > Speed Entry 

Speed Entry function allows: 

 Fast data entry for absent students in the morning (particularly home room/first period check) 
and for updating (variations and notes) 

 Use of keyboard for data entry (mouse is optional) 

 Student data loads automatically when students’ names are entered 
 
There are options to: 

 Enter student data for one or for multiple students 

 Select the session/period 

 Change the date 

 Enter a code for a range of dates 

 Keep data on committal 

 

Activity: Absences Through Speed Entry 

Lesson Attendance > Speed Entry 

Enter data individually for students who are away all day today: 

 Type DAV,C in the Student/Ref. No. field and press <Tab> 

 Leave All Day (the default) and the current date 
 

 
 

 Click OK  

 Read the note in the bottom left of the window 
 

 Repeat this for  
o Katherine Elliott 
o Bradley Uifelean 
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3.7.1 Speed Entry-Keep Data on Committal 

Activity 

Lesson Attendance > Speed Entry 

Enter data for the following students who are absent in the afternoon only. 

 Tick Keep Data on Committal to save the settings for use with the second student 

 Type AMB,K in the Student/Ref. No. field and press <Tab> 

 Select PM option 

 Choose the Attendance Code M – comment Sick 
 

 
 

 Repeat this for Nora Chum 
 

 Uncheck Keep Data on Committal 
 

Note:  If you attempt to overwrite data that has a ‘resolved’ status (‘/’, ‘T’, ‘R’, ‘Z’, ‘E’, ‘W’, 
‘M’, ‘L’ and ‘C’), with an ‘unresolved’ status code (‘U’ and ‘X’), you will be taken to Day View 
to view/edit the day view record.  This will also occur if you are updating a secondary 
student’s morning or afternoon session and the session’s periods are not all the same. Z 
and W codes are managed by the Behaviour Manager module.  They cannot be selected in 
Lesson Attendance when entering absences as it is a Department of Education and Training 
requirement that all schools use the Behaviour module to record instances of suspensions 
and withdrawals. 
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3.7.2 Speed Entry – Range of Dates 

Activity 

Lesson Attendance > Speed Entry 

 Load Kristof Farmer 

 Select the Range of Dates option 

 Enter the start and end dates (Monday to Friday of last week), code and comment 
 

 
 

 Click OK 
 

Note: When typing part of the student name into the search window and hitting enter or Tab 
on the keyboard, the select window will display student names in the format of 
<Surname><Preferred Name>. This also occurs in the Lates window. 
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3.7.3 Speed Entry-More than one Student 

Activity 

Lesson Attendance > Speed Entry 

 Check Enter data for more than one student 

 Use Find  to locate the Year 7 boys, highlight three names in the list and click Select 

 Select the PM option 

 Leave today’s date 

 Enter the Attendance Code T and comment 
 

  
 
At the bottom left of screen, some codes are provided on the status of the entry: 

 S – Absences saved down with no exceptions 

 E – There were one or more exceptions so students already have Attendance codes added to 
those dates 

 C – No changes to student, possibly dates were within a school holidays 
 

 Click OK 
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The Year 8 students are going to SciTech this morning. 

 Find  teaching set 8SCI_1 
 

 
 

 Select All the students in the browse set 

 Click Periods  

 Then click Add  
 

 Select Periods 1  and 2 and click OK 
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 Enter an appropriate Code and Comment 
 

 
 

 Click OK 
 

Note the Status displays the letter S indicating that the Absence has been saved down 
 

 
 
 

 
 

 Click OK 
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The Swimming Squad students are attending a Training Camp today and tomorrow. 

 Use Speed Entry to enter these details 

 Find the 2016 Swimming Squad 
 

 
 

 Click Find, Sort the student by Form, then click on Select and Yes 

 Enter the details from the screenshot below 
 

 
 

 Click OK 

Note: If there are any conflicts of existing data, an Exceptions Log window will open. Those 
student’s data would need to be checked through Day View or Week View 

 View the Exceptions Log if you are prompted 

 Exit out of Speed Entry  
 

 



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 86 of 157 

© 2016 Civica Pty Ltd 
 

3.7.4 Speed Entry-Creating Daily Records 

Activity: Adding a Student to the Current Roll 

General > Student Details 

 Click Add Student   

 Enter basic details for a new student 
 
Name: Melissa Hughes  
DOB: 7 June 2006 
Year: 5 
Form: Room 5 
 

 
 

 Click on the Additional tab 

 Enter an Entry Date of Monday of this week 

 Tick the Australian Citizen checkbox 
 

 
 

 Click OK to save the changes 

 Say Yes to continue to the Vaccination Schedule message 
 

 Click No to Timetabling 

 Close the Student Details  
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3.7.5 Speed Entry-Creating Daily Records  

Note: When enrolling a new secondary student and the Timetabling module is in use, 
ensure that he or she is placed in an appropriate cohort. 

Activity 

Lesson Attendance > Week View 

 Select Student Find  

 Load Melissa Hughes’ records 
 

 
 
Check attendance data in week view for Melissa Hughes.  A series of dashes will be in the records 
and no attendance data can be entered as no attendance record exists 

 
No daily records have been created for Melissa. 
 

 
 

 Exit out of Week View 
 

Lesson Attendance > Speed Entry 

 Enter HUGHES in the Student/Ref field and <Tab>.   

 Choose the Range of Dates option  

 Enter the Start Date as last Monday and the End Date as TODAY 

 Change the Attendance code to / - Present  
 

  
 

 Click OK.   
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The attendance record has now been created for the new student and data will be able to be 
recorded against this student 
 

 View Melissa’s records in Week View 
 

 
 

 Exit out of Week View 
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Activity: Review  

Complete each of the following tasks and making a note of the pathway taken. 

1. Kyle Pearse and Simon Rumble are absent from Sharon Oswald’s form class today.  Enter their 
absences. 
 
 
 
 
 
 
2. Kristof Farmer was absent very early in the Term 1.  We have now been advised that he was 
sick on those days.  Use Student View to update his records. 
 
 
 
 
 
 
3. The students in form 9-3 are going on an excursion to Parliament House today.  Use speed 
entry to record the absences. 
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3.8 Future Absences 

Lesson Attendance > Absences > Future Absences 

  
 
Future Absences allows: 

 Fast data entry for students who are expected to be absent in the future 

 Student data loads automatically in Day View when the daily records are created for the 
recorded dates 

 Aids in determining appropriate dates for school activities 

 Reduces the risk of data error resulting from staff not being aware of students’ whereabouts 
 
Options include:  

 Sort the list of future absences 

 Filter the list of future absences 

 Print future absences list 

 Add records 

 Delete records 

 Edit records 

 Show/hide expired records 

 Purge expired records 
 
  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 91 of 157 

© 2016 Civica Pty Ltd 
 

3.8.1 Adding Future Absences 

Activity: Entering Future Absences 

Lesson Attendance > Absences > Future Absences 

 View Future Absences recorded for the rest of this year 
 

The Year 6’s are going on an excursion to AQWA on the last day of this term.   

Term Dates for students for 2016: 

Term 1 – Monday 1 February to  Friday 8 April 
Term 2 – Monday 25 April   to  Friday  1 July 
Term 3 – Monday 18 July  to  Friday  23 September 
Term 4 – Monday 10 October  to  Thursday15 December 
 

 Click Add  

 Find  the Year 6 AQWA Excursion students  
 

 
 

 Enter the dates, code and comment. 
 

 
 

 Click Save and OK 

 Exit the Future Absences 
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Lesson Attendance > Absences > Future Absences 

Students from Junior Choir will be absent on the morning of 5th December.  They will be singing at 
the local shopping centre 
 

 Click Add  

 Find the Senior Choir  
 

 
 

 Enter the following details 
 

 
 

 Click Save  
 

 
 

 Click OK and Exit 
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Lesson Attendance > Absences > Future Absences 

Some Year 8 students will be absent next Wednesday Periods 3 and 4 for an Anger Management 
course. 

 Click Add  

 Find Students   

 Select Tamara Bandy and Alecia Bishop from Form 8.1 
 

 
 

 Click  
 

 Enter next Wednesday’s date  

 Tick Wednesday  
 

 
 

 Click Periods   
 

 Click  
 

 
 

 Check 3 and 4, and click OK 
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 Select the relevant attendance code and enter a comment 
 

 
 

 Click Save 
 

 
 

 Click OK and Exit 
 

View the newly added Future Absences 
 

 
 
 
 

  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 95 of 157 

© 2016 Civica Pty Ltd 
 

3.8.2 Filtering Future Absences 

Activity: Viewing Future Absences 

Lesson Attendance > Absences > Future Absences 

 Click Filter   

 Enter the date range 1st December 2016 to 15th December 2016 
 

 
 

 Click  
 

 
 

 View the Future Absences that fall within the date range 
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 Filter the list again by selecting Form 8.1 from the drop down menu 
 

 
 

 Click  

 
The students in 08.1 who are members of the Senior Choir are displayed 
 

 
 

 Print  the list of students to screen 
 

 
 

 Close the report 
 

 Clear  the filtered selection  
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3.8.3 Editing Future Absences 

Activity: Edit Future Absences 

Lesson Attendance > Absences > Future Absences 

The date of the Albert family’s holiday has been changed. The school has also determined that this 
is not an approved absence so the future absence will need to be edited. 
 

 Click Filter  and select Attendance Code ‘V’ 

 Change the From date to 5 December 
 

 
 

 Click  

 Highlight Jackie Albert and Jennifer Zolter-Albert  

 Click Edit  

 Change the Attendance Code to K-Unauthorised Vacation and edit the Comment 
 

 
 

 Click Save  

  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 98 of 157 

© 2016 Civica Pty Ltd 
 

 

The Junior Choir event at Karrinyup Shopping Centre has been re-scheduled to December 12th 

 Click Filter  and select Attendance Code ‘E 
 

 
 

 Click  

 Highlight all the students attending the event at the Karrinyup Shopping Centre 
 

 
 

 Click Edit   
 

 

  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 99 of 157 

© 2016 Civica Pty Ltd 
 

 

 

 Change the date to 12 December 
 

 
 

 Click Save 

Note: Future Absences can only be edited for multiple students if the absences have the 
same  Start Date, End Date, Start Period, End Period and Attendance Code 

View the edited Future Absence 
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Due to poor behavior all Year 8 End of Year Excursions have been cancelled. 

 Click on Clear Filter  

 Filter  to Year 8 and Attendance code E  

Note: Ensure you select Year 8 and not Year -8. The negative before a Year designation is 
for schools that have an extended pre-enrolment programme 

 Click  

  Highlight all the End of Year Excursions  
 

 
 

 

 Click Delete  
 

 
 

 Click Yes to the message 
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3.9 Creating Daily Records 

Attendance records are created daily. The best time to do this is probably late each day, while a 
staff member has several minutes to spend on duties that do not involve use of Integris. Other staff 
can continue using the software while daily records are created. 

Note: It is recommended that you create the daily register only one day ahead.  You may be 
tempted to create several days at once, but if a student enrols or moves between form 
groups during that time, you will not be able to recreate the appropriate attendance sheets 
with the revised registration details as easily as if you create the records daily. You will also 
make it difficult to find students in their current form/teaching set if you create records 
more than one day in advance. 

To create daily records for the school or for individual Year Groups: 

 Open the Parameters window from the Lesson Attendance sidebar 

 Double click on the Create Daily Records icon.  This opens the Create Daily Records window 
that displays all the year groups in the school. On each Year Group line is the date for which 
current records have been created for that Year Group.   

Note: Only year groups that are due to attend school on the date shown will be displayed in 
the window.  For example, if you open the Create Daily Records window before the start of 
the attendance year, no year groups will be displayed.  Change the date (e.g. to the first day 
of the attendance year) and the year groups will be displayed. 

 
 

 Enter the date for which you are creating records in the Create New Records Up To field  

 In the unlikely event that you need to create records for only a selection of Year Groups, click 
the Deselect All button to uncheck the check boxes and then check those Year Groups that 
you do wish to create daily records for 

 Click the Create button to create records for the date selected 
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Note: Use the Speed Entry window to enter attendance data for students who have enrolled 
after daily records have been created.  Once you have done this, the student’s record for 
that day will be displayed in Day View and can then be edited in the usual way. 
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Activity: 

Lesson Attendance > Week View 
 

View the lesson attendance records for the AQWA group for the last week of the current 
term 

 Select Student Find 

 Find  the AQWA group 
 

 
 

 Scroll to the last week of the current term 
 
Term Dates for students for 2016: 
 
Term 1 – Monday 1 February to  Friday 8 April 
Term 2 – Monday 25 April   to  Friday  1 July 
Term 3 – Monday 18 July  to  Friday  23 September 
Term 4 – Monday 10 October  to  Thursday15 December 
 
The daily records have only been created up to the second last day of term, as indicated by the 
dots rather than the forward slashes. Exit the screen. 
 

 
 

 Close Week View 

  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 104 of 157 

© 2016 Civica Pty Ltd 
 

Lesson Attendance > Parameters > Create Daily Records 

 Create daily records for one more school day (the last day of the current term) for all Year 
Groups 

 Enter the last day of term in the date field 
 

 
 

 Click Create 
 

 
 

 Click Yes  
 

 
 

 Click  
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Lesson Attendance > Week View 

 View the lesson attendance records for the last week of the current term 

 Select Student Find 

 Find  the AQWA group  
 

 
 
 
The daily records have been created up to the last day of term and their absences entered. 
 

 
 

 Click on  
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3.10 Absence and Lates Follow-up 

Schools can set up two absence and lates follow-up letters to be used in following up daily 
absences as well as lates recorded in Lesson Attendance.  All letters are editable at the time of 
printing. 
 

3.10.1 Setting up Letter Defaults 

 

Activity: Absence Letters 

Lesson Attendance > Parameters > Defaults > Absence Letter 

 
 

 As we will be editing the set-up of letters, click on the Edit button   

 View Absence Letter 1  
 
This letter has been set up for schools to use and may be edited.  A second letter may also be 
added. 
 

 Type some text in Absence Letter 2 
 

 
 

 Leave the Search for students with these Unresolved Absences as All Unresolved Codes 
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Lesson Attendance > Parameters > Defaults > Lates Letter 

 Enter in some text for Lates Letter 2  
 

 
 

Lesson Attendance > Parameters > Defaults > Letter Defaults 

 
 

 View options for signatories - the default setting is Form Teacher 

 Click Edit   

 Select User defined  

 Enter your Name and Position 

 Select the Letter Recipient as Send letters to all marked as Family Mail Marker 

 Click on OK to save and Exit 
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3.10.2 Overview of Absence Follow Up  

Absences > Absence Follow Up 

Absence Follow Up permits users to: 

 View daily absences and details of absences followed up   

 Produce follow-up letters  

 View the daily absences that have occurred since the last letter was sent 

 View the absences for which letters have been sent 

 View students’ letter histories and details of absences 
 
Options include:  

 Viewing absence follow-up by date range 

 Filtering the list of absences 

 Sorting the list of absences  

 Viewing details of absence details for a selected student 

 Select letter destination 

 Select the letter to be sent  

 Edit the body of the letter 
 

3.10.3 Absence Follow Up 

Activity: Absence Follow Up 

Lesson Attendance > Absences > Absence Follow Up 

 Enter the date range 1st February to TODAY  

 Leave the Query as Whole School 
 

 
 

 Click OK  

 Click on the column headers to view sort options 
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Lesson Attendance > Absences > Absence Follow Up 

View details of Tiffani Price’s absences. 

 Highlight Tamara Bandy 

 Click Open Student View (or double click on the student’s name) 
 

The Student View window opens.  Data can be edited and saved in the Student View window, if 
required. It can also be printed. 
 

 Click Exit  

 Click Print Student View 

 Print the report to the screen 
 

Generating Absence Follow Up Letters 

 Click the Total column header twice 

 Highlight all of the students with two or more absences  
 

 
 

 Click Follow Up Letter   
 

 
 

 Click Yes , click OK to Print to the screen 
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 Leave the Family Mail Marker option   

 Leave the Letter 1 option 
 

 
 

 Click OK 

 View the letters 

 Close the letters 

 Note that today’s date is recorded in the Date of Last Letter column 
 

Lesson Attendance > Absences > Absence Follow Up > Letter History 

To view a summary of all absence letters sent to a student for the current year: 

 Highlight Jackie Albert’s record 

 Click Letter History and print the report to the screen 

 Close the report 
 

To view a summary of all absence letters sent to Year 4 students 

 Sort the list by Year 

 Highlight records for all students in Year 4 

 Click Letter History and print the summary to screen  

 Exit Absence Follow Up  
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3.10.4 Lates Follow Up 

Activity: Lates Follow Up 

Lesson Attendance > Absences > Lates Follow Up 

 View the Lates from 1st February  to TODAY 
 

 
 

 Click OK 

 Highlight the first student 
 

 Click Follow Up Letter and Yes 

 Send the letters to the screen 

 View and close Letter 1 
 

 Highlight the second student 

 Click Follow Up Letter and Yes 

 Select the Parent/Guardian of… option 

 Select the Letter 2 option 

 Click OK 

 View then close the letter 

 Exit  Lates Follow Up 
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3.10.5 Continuous Absences 

Lesson Attendance > Absences > Continuous Absences  

The Continuous Absence Report is accessed through the Absences menu. The report is activated 
by double clicking on the Continuous Absences option in this window.  The report will display 
students who have had periods of absence and meet the absence requirements as entered in the 
Continuous Absence window. 
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3.10.6 Continuous Absences 

Activity: Continuous Absences 

Lesson Attendance > Absences > Continuous Absences  

 Enter the date range 1 February to TODAY  

 Leave Year Group as All 

 Check Only report on all day absences 
 

 
 

 Click OK 
 
Students with 2 or more days of continuous absences appear  
 

 
 

 

 Print the report to the screen  

 Close the report 
 

 Highlight a record  

 Click Details  

 Print the report to the screen  

 Close the report 
 

LEAVE THE CONTINUOUS ABSENCES WINDOW OPEN 
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3.10.7 Continuous Absences-Mail Merge Export 

Lesson Attendance > Absences > Continuous Absences  

An export facility in Continuous Absences allows users to export attendance data so that it can be 
used in mail merge software.  A CSV or tab file can be produced which can be merged to user-
designed documents. 

To create an export file: 

 Highlight the record(s) you want included in the export 

 Click Export to File  
 

 
 

 Select the required options 

 Click Export 

 Navigate to the desired destination and click Save 
 
The data can now be merged to mail merge document. 
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3.10.8 Continuous Absences-Mail Merge Export 

Activity: Export Continuous Absences for Mail Merge 

Lesson Attendance > Absences > Continuous Absences  

 
 

 Highlight all the students 
 

 Click  

 Click on Export Header Row and click Export 
 

 
 

 Navigate to the Desktop and click Save 

 Click OK 
 

A csv file has been produced for use in a subsequent mail merge. 
 

 Minimise Integris and open the Absence Export csv file  

 Close the file 
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4 Lesson Attendance Reports  

Lesson Attendance > Reports > Attendance Forms > Morning Absentee Report  

Note: This Report is for Secondary Schools only. 

 Enter TODAY’s date 

 Check Show PM codes 

 Select Years 7 to 12 
 

 
 

 Print the report to the screen 

Note: The Instructions that have been set up as the default in Parameters > Defaults > 
Report Instructions may be edited here. 
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Lesson Attendance > Reports > Attendance Forms > Form/Year Absentee Report  

 Primary: Select Room 4  

 Secondary: Select 07.1  

 Enter the date range 1st  February to TODAY 

 Select All Lesson Absences  

 

 
 

 Print the report to the screen 
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Lesson Attendance > Reports > Attendance Forms > Individual Absentee Report  

 Primary: Find Jackie Albert 

 Secondary: Find Tamara Bandy 

 Enter the date range 1st February to TODAY 

 Select All Lesson Absences 
 

 
 

 Print the report to the screen 
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Lesson Attendance > Reports > Attendance Forms > Teaching Set Attendance Register 
(Secondary only) 

 Select Period 1 and 10 Weeks starting on 1st February  

 Use Find to locate Ms Oswald 
 

 
 

 Print the report to the screen 
 

Note: Schools that do not have a form period prior to period one can use the Teaching Set 
Attendance Register report.  In such cases, the report would be printed for each teacher 
who has a period one teaching set.  Schools would usually print the report for the number 
of weeks in each term. 
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Lesson Attendance > Reports > Attendance Records > Absent Students by Day or Period  

 Enter TODAY’s date 

 Filter by Form 

 Primary: select Rooms 4  

 Secondary: select cycle 2016-05 and 7.1  
 

 
 

 Print the report to the screen 
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Lesson Attendance > Reports > Attendance Records > Attendance Corrections  

 Primary: Find Jackie Albert 

 Secondary: Find Tamara Bandy 

 Enter the date range 1st February to TODAY  
 

 
 

 Print the report to the screen 
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Lesson Attendance > Reports > Attendance Records > Lesson Attendance Summary  

 Primary: Find Jackie Albert 

 Secondary: Find Tamara Bandy 

 Enter the date range 1st February to TODAY  

 Select All Lesson Absences  
 

 
 

 Print the report to the screen 
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Lesson Attendance > Reports > Analysis Reports > Attendance Analysis for Students  

 Primary: select Room 4  

 Secondary: select 7.1  

 Enter the date range 1st February to TODAY  
 

 
 

 Print the report to the screen 
 

Note: Two analysis reports for each form are produced. One for percentage attendance per 
student and the other provides attendance details by Attendance Code for each student. 
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Lesson Attendance > Reports > Analysis Reports > Attendance Summary (am/pm) 

 Primary: Find Jackie Albert 

 Secondary: Find Tamara Bandy 

 Enter the date range 1st February to TODAY  
 

 
 

 Print the report to the screen 
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Lesson Attendance > Reports > Subject Attendance > Absence History Report by Single 
Staff (Secondary only) 

 Enter the date range 1st February to TODAY  

 Click Find button to populate the window with Ms Oswald’s teaching sets 
 

 
 

 Print the report to the screen 
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4.1.1 Custom Reports 

Lesson Attendance > Reports > Custom Reports 

The standard Integris Custom Report functionality is available in the following Lesson Attendance 
Reports: 
 

 Individual Absentee Report 

 Lesson Attendance Summary 

 Group Attendance Analysis Summary 

 Attendance Summary (am/pm) 

 Students with a specific number of half-day absences or more 

 Half-Day Absence Totals 
 

This enables users to set up and save report selections that will be used again.  
 
 

Activity 

Lesson Attendance > Reports > Analysis Reports > Students with a specific number of half 
day absences or more. 

 Edit the Title to read Students with ten half-day absences or more 

 Sort by Year, then Form 

 Enter the date range for the current semester 

 Enter 10 in Half day absences cut-off 
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 Click Save as a Custom Report   

 Enter a name for the custom report 
 

 
 

 Click OK 
 
The settings will now appear in the Custom Reports folder in the Lesson Attendance Reports 
window 
 

 
 

 Click Allow Custom Report to be used by others  

 Close Reports 
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4.1.2 Evacuation Report 

Activity: Print Evacuation Report 

Top Toolbar > Print Evacuation Report  

 Click Print Evacuation Report  

 From Report Type choose All Students by Form  

 Leave the date field with TODAY’s date 

 Select either the Primary or 2016-5 Cycle as shown below, depending on your school type 

Note: The periods for primary denote the AM and PM sessions, that is, 1 is AM and 2 is PM 

     
 
  Primary     Secondary 
 

 Print the report to the screen 
 

Note: The default output for this report is directly to the printer. 
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4.2 Changing Students’ Roll Status 

When a student’s details change in any of the following ways, their status will be updated in 
Lesson Attendance: 

 changing students’ FTE 

 changing form groups 

 changing roll status (individual student or group of students) 
 

4.2.1 Change Part-time Status  

General > Student Details > Additional Information 

When a student’s FTE status (in Administration Manager Module > Student Details) changes from 
full-time to part-time or from part-time to full time, their new status is passed to the Lesson 
Attendance module and reflected in their records when the next Daily Records are created.  
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4.2.2 Allocating Part Time Status to Bulk Students 

Activity: Speed Edit Part Time Status 

Admin > Speed Edit 

 Select the Area – FTE and Part time status 
 

 
 

 Select  Year Group: K 

 Click Select All   

 Enter the New Value 0.5 
 

 
 

 Click to Apply Change  

 Click Save 
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 Click OK  
 

 
 

 Click Yes 
 

 Select the Custom  radio button 

 The students will be attending Monday and Tuesday (full days) and Wednesday (AM only) 

 Click each of the periods where the student(s) will not be attending 
 

 
 

 Check the box Use Selected for All 

 Click OK 

 Close the Speed Edit window 
 

 
  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 132 of 157 

© 2016 Civica Pty Ltd 
 

4.2.3 Change Form 

When a student changes from one form group to another, the details are passed to the Lesson 
Attendance module. 
 

Activity 

General > Student Details 

Change Simon Ward’s form to Room 6.  Make the change effective from two school days ago. 
 

 Use Search to locate Simon Ward’s records  

 Click Edit  

 Change Simon’s form to 7.2 

 Click OK 

 Enter the date two school days ago and click OK 
 

Lesson Attendance > Day View 

 View the change in Day View and scroll through before and after date of change 
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4.2.4 Change Roll Status-Individual Student 

If a student’s roll status is changed in Administration Manager > Student Details, the user will be 
asked if they wish to back-date the change and be prompted for a date.  
 

Activity: Former Roll 

General > Student Details 

Move Tim Goddard to the former roll.  
 

 Use Search to locate Tim Goddard’s  records  

 Click Move Student to Former Roll   

 Click Yes  

 Enter TODAY’s date as the leave date, Victoria as his destination and reason as Moved 
Address 

 Click OK 

 Click Yes, as we do want to remove him from his groups 

 Enter TODAY’s date as the date on which his roll status is to change 

 Click OK 

Lesson Attendance > Week View 

 Select Student Find 

 Click on the binoculars  

 Find Tim Goddard on the Former Roll 

 View the change in Week View  
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5 Review  

Activity: Review 

Write down the steps/path you would take to complete these tasks 

1. Enter absence data for a student (several options). 
 
 
 
 
 
2. Produce a Form List for recording absences. 
 
 
 
 
 
3. View attendance codes and their descriptions (name two places). 
 
 
 
 
 
4. Update lesson attendance records for students who have brought notes. 
 
 
 
 
 
5. Enter known absences for dates in the future. 
 
 
 
 
 
6. Produce follow-up letters to parents/guardians. 
 
 
 
 
 
7. Create a New Attendance Year * (Instructions are included as Appendix 1) 
 
 
 
 
 
 
 

 
  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 135 of 157 

© 2016 Civica Pty Ltd 
 

6 Appendix 1: Creating a New Attendance Year 
 

The Attendance Year relies on the school year being set up in School Details.  This is completed in 
schools as part of the Year End function.  Holidays and Close days must be entered.   

6.1 Set up the School Calendar for the New Year  

Note: It is necessary to make a copy of the data file as it stands before you set up a new 
academic year, in case you inadvertently delete the current year’s data. The SIS Backup 
Wizard should be used to make a backup of your data at this time. 

6.1.1 Creating a new school year 

ACTIVITY 

Set up a new school year for next year (2016). 

General > School Details 

 Click Display School Diary  

 Click Set Up School Year  

 Click Display Diary for Specified Year to double check that the following year has not 
already been set up 

 

 
 

 Click Set up year structure  

 Click OK 

 Enter the year in the School Year field and press <Tab>   
 

 
 

 Click Yes when asked if you want to discard last year’s data  
 

 Change  to  
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Set up terms within the new year:  

 Click Add Term  to add details of terms, (these are entered one at a time), dates may be 
typed in or selected via the Activity Calendar button 

 

 

 
 

 Add the other terms for 2017 
 

 
 

 Click OK  
 

Note: These dates were correct at the time of printing.  Please refer to 
http://www.det.wa.edu.au/education/termdates/to confirm dates prior to input. 

 

Note: School Terms are always entered as starting on a Monday.  If the 
school is not open on the Monday, it may be entered as a Closed day in 

the School Diary. 
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Identify the days within the school year that the school will be closed 
 

 In the School Diary window click on Toggle Paintbrush   
 

 Click in the green School Development cell 

 Scroll to the 30th January 

 Enter Monday 30th January and Tuesday 31st January as School Development days 

Hint:  Click on the actual date.  This will highlight all 3 cells.  To correct an error, click in  the 
white cell, click on the error and reselect the correct colour code 
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 Click in the blue Holiday  cell 

 Use the blue chevrons  to navigate to March 

 Enter Mon 6th  as a public holiday 
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 Use the blue chevrons  to navigate to April 

 Enter Tues 25th  as a public holiday 
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 Navigate to June 

 Enter Monday 5th June as a public holiday 
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 Navigate to July 

 Change the Paintbrush Code to School Development 

 Mark 17th July as a School Development Day 
 

 

 

 Turn the paintbrush off  

 Click  

 

Note: At school, staff need to ensure that all the appropriate holidays and School 
Development Days would be entered for the entire year. 

 

  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 142 of 157 

© 2016 Civica Pty Ltd 
 

6.2 Setting up a New Attendance Year 

 
Before Setting up your new attendance year, ensure that: 
 

 Your data file has been backed up  

 If you are using timetabling, the school’s timetable specifies which periods are AM and which 
are PM in Timetabling > Timetable Setup > Timetable Cycles > Master Period Structure 

 

Activity 

Lesson Attendance > Parameters > Create New Attendance Year 

 View prerequisites to setting up the new Attendance Year  
 

 
 

 Click Proceed  

 Enter the following dates below and click OK  
 

 
 

It is recommended that the Attendance Year is always started on a 
Monday. 
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FTE Warning Report 

An FTE warning check runs if either 
1. K students (and not P) are included in the current LA structure 
2. P students (and not K) are included in the current LA structure 
3. Both K and P students are included 

 
The FTE of the all of the students on the current roll is checked against the expected value for their 
year group. 
 
The expected FTE for a student in each year is as follows: 
 

Lesson Year Group Expected FTE 

Year group K FTE < 1.0 

All other Year Groups FTE = 1.0 

If all students on the current roll have the expected FTE value based on their Year Group then the 
Create New Year process will proceed as per the current process. 
 
Where neither Year Group K or P are defined as Year Groups using Lesson Attendance then the 
check on Student FTE will not be run and the Create New Year process will proceed as per the 
current process. This includes Secondary Schools. 
 
If at least one student is found on the current roll whose FTE value does not match the expected 
value in the table above, then a warning report is generated as shown below on the next page. 
 
The warning report orders students by surname and displays the following: 
 

 Student Name 

 Year Group 

 Form 

 FTE 

 Expected FTE 
 
The report will appear as a screen report, without the user being presented with the Report 
Destination window. The user can print the report to printer via the printer icon at the top left of the 
screen report if required. 
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 If student’s FTE needs to be corrected, click Yes 

 If student FTE values are correct click No 
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 Click Yes 

Note:  Schools would copy the previous year’s set-up if the Period Availability Structures 
and Year Groups remain the same from one year to the next which is normally the case. 

 

 
 

 View Cycle Start Dates and Descriptions   
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Cycle descriptions can be edited to display in Day View the terminology used in your school. 
 

 Place your cursor immediately before Week 1  

 Type Term 1 and a space 

 Highlight Term 1 and a space - <Ctrl> +C to copy 

 Place your cursor immediately before Week 2  

 <Ctrl> + V to paste 

 Continue for all remaining weeks in Term 1 

 Overtype Week 10 and Week 11 with Holidays 
 

 

Note: In school, you would continue to edit the descriptions for the entire year.  

 Click Save and Yes 

 Click Next and Yes 

 View the available period structures 
 

 

Note: Alternative period structures could be added if required. 

 Click Next  
 

 
 

 Click Yes 
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 Make sure Year Groups K to 12 are selected to be included in Lesson Attendance 
 

 
 

 Click Next 

 Select the appropriate Period Structure for each year group  
o Primary for Years K - 6 
o Timetabling for Years 7 -12 

 

 
 

 Click Save 

 Click Finish, Yes and OK 
 
 
 
 

  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 148 of 157 

© 2016 Civica Pty Ltd 
 

 

 

 

Note: End of Year Dates for Years 11 and 12 in Secondary Schools will need to be edited 
once these dates are confirmed.  

These can be edited through Lesson Attendance > Parameters > Year Groups. Click on the 

Edit Pencil and then the calendars next to the End Date field. 

 

 

 

  



 
Integris Lesson Attendance Training Notes 2016.Docx 18-Jan-16 

Page 149 of 157 

© 2016 Civica Pty Ltd 
 

7 Appendix 2: Systems Administrator Tasks 

7.1 User Access 

 

Activity: Setting Access for Users 

General > Control > Users 

 Double click on Elaine Abbott 

 Click on the yellow folder to the left of Lesson Attendance to view the contents 

 Click Absences 

 Double click on Absence Follow Up in the right pane to give her access to this section of the 
software 

 Repeat to give her access to Student View as well 
 

 
 
 

 Enable Elaine’s access to other parts of Lesson Attendance that a teacher might need 

 Click OK to save 
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Copying User Access Rights 

General > Control > Users 

 Click Copy Access Rights between Users   

 Highlight Abbott in the left-hand pane and Alan, Best and Briggs in the right-hand pane 
 

 
 

 Click OK and Yes 

 Click OK to close 
 
Alan, Best and Briggs now have identical access rights to Abbott. 
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8 Appendix 3: Period Availability Structures 

Parameters > Period Availability Structures 

We can view the way primary and secondary structures are set up.  A school that uses the 
Timetable module may have a Timetabling period structure selected for students on the timetable. 
 
New structures can be created and then linked to Year Groups in Lesson Attendance > 
Parameters.  The new structure will be picked up for the Year Group when Daily Records are next 
created. 
 

8.1.1 Creating a Period Availability Structure 

Activity:  

Lesson Attendance > Parameters > Period Availability Structures 

Create a period availability structure for secondary students.  They are going to have five teaching 
periods every day.  
 

 Click Add    

 Click Create Blank   
 

 
 

 Click Yes  

 Click Create Blank 

 Enter the Period Structure Name Secondary and the period types for Monday  
 

 
. 
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 Click Fill Structure Down   
 

 
 

 Click Yes   

 

  
 

 Save and Close   
 
The Secondary Period availability structure is now ready to be linked to a Year Group 
 

Note:  A secondary structure would be set up in a school with secondary students, which 
are not using the timetable module, for example a small District High School. 
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8.1.2 Attaching Year Groups to Period Structures 

Lesson Attendance > Parameters > Year Groups 

Year groups are attached to period structures.  Period structures can be edited for existing year 

groups by selecting Edit Year Groups.   New Year groups may be added by clicking Add New 

Year Group.  
 

8.1.3 Adding New Year Groups to Lesson Attendance 

Activity 

Lesson Attendance > Parameters > Year Groups 

 Click Add New Year Group   

 Select K (Kindergarten) from the Year Group list 

 Make the start as the beginning of the current week 

 Choose the Primary structure from the Period Structure List 

 

 
 

 Click on OK  
 

 
 

 Click Yes 
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Lesson Attendance > Parameters > Year Groups 

Year Groups can by edited by Clicking  Edit Year Groups   

 

 
 

 Close the window 
 
 

 
 
If a change is made eg: Adding Year 6 to timetabling, after clicking the Save button, the following  
message will display 
 

 
 
The user would enter their the password and click OK 
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9 Support 
Should you require support please contact the Customer Service Centre (CSC) at the 
Department of Education  
 
Contact details below: 

9.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 

9.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 

9.3 Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 

10 Online Manuals and Training Notes 

10.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
www.civicaeducation.com.au. 
 
Select online manual login. 
Username: school 
Password: help 
 

11 STIMS Project 
The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
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